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~ GETTING STARTED

GETTING STARTED

Havc you always wanted to Jearn how to play the piano? The
Miracle® Piano Teaching System with your Macintosh® and MID1
piano keyboard can help you do it!

QUICK START CARD

The Miracle runs with various Macintosh compurers and MIDI
keyboards. See the Quick Start Card for system requirements and
any special installation instructions that apply to your version of the
program, That card also lists The Miracle Technical Support offices.
For general installation instructions, see Justalling The Miracle in this
section. For general information about The Miracle and the
Macintosh, see Macintosh Conventions at the end of this manual.

Caution: Please don't run a screen saver with The Miracle, or you
may suddenly shut down and lose student records for the current
session. See the Miracle Read Me file in the Miracle folder on your
hard drive to learn about any other cautions that apply to your
version of software,

CONNECTING YOUR MID] KEYBOARD

The Miracle is designed to run with most General MIDI
keyboards. Refer to your General MIDI keyboard owner’s manual
and the system requirements on The Miracle Quick Start Card ro
determine whether your MIDI keyboard will work.

Before attempting to install or run The Miracle software, please
make sure your MIDI keyboard is connected to your Macinrosh
MIDI adapter, and is turned on. Make sute the MIDI out cable is
plugged into the MIDI in of the piano and the MIDI in cable is
plu_g?ed into the MIDI out of the piano. You must also have the
Apple MIDI Manager installed as an active exrension in your
I\t}lllacintosh System Folder (the install program automatically loads
is).
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INSTALLING THE MIRACLE

To install The Miracle on your Macintosh's hard disk drive:

1. Connect and turn on your MIDI keyboard (see Connecting Your
MIDI Keyboard).

2 'Turn on your Macintosh.

3. Insert Miracle Disk #1 into your floppy drive.

4, Open the disk by double-clicking it {if it is not already open).
5. Double-click the Installer to run it

6. Click the Instalt bucton.

7. During installation, the Installer prompts you to insert disks as

needed.

8. At the end of installation, the Installer prompts you to click the
Restart button.

Once installation is complete and the Macintosh restarts, the
Miracle program icon appears in the Miracle folder on your hard
drive {or wherever you choose to put it). You can drag this icon to
your Desktop, or use the File menu Make Alias and add it to the
Apple menu in your System Folder.
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LAUNCHING THE MIRACLE

‘To launch the program:

1. Double-click the Miracle program icon in the Miracke folder {or
on your desktop if you dragged it there).

2. If your monitor settings are not at an optimum, the Miracle
Monditors dialog box may appear. Click Change or Run to

choose a monitor color setting,

3. The Miracle title screen appears. You can listen to the song or
click to interrupt ir.

4. The Open Student dialog box appears.

5. Choose a command button as follows:

¢+ New Student - Enroll in The Miracle Piano Teaching
System, so you can track your progress. See Envolling in The
Miracle.

* Browse - Open the Welcome didlog box and choose Begin -

Lesson or Conservatory.
* Quit - Exits the program and retuens to the Desktop.

Note: After you enroll, the Open Student dialog box lists your
name and changes the Browse button to OK. You can then either
select Browse OR your name from the list and choose OK to open
!tbhi Welcome dialog box (shown in Enrolling in The Miracle

clow).
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ENROLLING IN THE MIRACLE
If you are a brand new student, enroll in The Miracle as follows:

1. On the Open Student dialog box, choase the New Student
command button.

The New Student dialog box appears.

IRNCITN Pl 3100t T
rihante EI
uy

mm e

2. Type your Full name and press Tab; type your Nickname and
press Tab; type your Birthdate in MM DD YY formar and click
OK

3. The Open Student dialog box reappears. Select your name and
click OK.
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The Welcome dialog box appears.

4. Choose a command button as shown:

+ Begin Lesson - Go to your Lesson. (After you complete the
first Lesson, this command button changes to Resume
Lesson. See Classroom. in Using the Software.)

+ Conservatory - Go to the main menu. See 7he Miracle
Conservatory.




THE MIRACLE® PIANO: TEACHING SYSTEM SOFTWARE




=

THE MIRACLE
CONSERVATORY

The Miracle main menu is the Miracle Conservatory.

=

file Edit Goto Help

In the Miracle Conservatory, software functions are organized into
the following six rooms. The chapter Using the Software ofters
specific instructions for each of the roems by name, including:

» Administration - Edit or delete students, set system features
{metronome volume, MIDI patch maps), and check your
progress.

¢ Classroom - Go to a specific Chapter or resume your current
Lesson.

» Arcade - Play arcade-style games or the Jukebox.

¢ Studio - Record and play back your own performances.
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* Performance Hall - Play with The Miracle Orchestl;_a.

. » Practice Room - Pick your practice mode, stich as practice notes
or practice rhythms, .

Click any room to open its diafog box of commands, or open its
dialog box from the Conservatory Go to menu.

To return to the Conservatory from any room, choose
‘Conservatory from the Go to menu or press #K.

You can also get online help from the Help and 2 menus. See
Online Help. & _ .

CONSERVATORY MENUS

" & file Edit Gotie Help : £

Click to open the pull-down and drag to choose commands. For
some commands, you can press the command key (88) and the
indicared letter without pulling down the menu. See Macintosh
Conventions at the end OEE this manual.

Note: The Edit menu is only active when you are typing Student
information, such as your name. See Administration in Using the

Software.

The Conservatory menu bar includes the active menus and
commands shown on the chart.
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ONLINE HELP

In the Conservatory, online help is available from the Help and &
menus on the menu bar.

The Miracle Help
To use The Miracle floating window help:
1. Choose Show Help on the Help menu, or press 38H.

The floating Help window appears. You can click and drag on
the title bar to move this window apywhere you want on your
screen,

Thig is The Miracle's
Flaating Help windoe .
Move your mouse over

buttons, windows, or any
othar areas that you'd Tike
to know more about, then
look here for a brief
wplanation.

. Move the mouse and point at buttons, windows, or other areas,

then read the description in the floating window.

3. To exir online help, choose Hide Help on the Help menu, or

press # H.

Note: You can also click the close box in the upper left corner of
the floating window.

Balioon Help

Te use Macintosh Balloon Help (available with System 7.0 or
higher):

1. Choose Show Balloons on the & menu.

2. Move the mouse and point at buttons, windows, or other areas,

then read the description in the floating window.

3. Choose Hide Balloons on the 2 menu to tum Balloon Help

off.

10



ONLINE GLOSSARY

The Help menu has a Glossary command, which lets you look up
definitions of musical terms used in The Miracle.

To use the Glossary:
1. Choose Glossary on the Help menu. The Glossary dialog box

appeats.

Glessary ST

Ird
Sth
Anajur

A i

Aalnor first v
AT

accidental
acconpaninent

S miaor

beam
Beatles
 Boethoven
Brahimns

2. On the left side of the screen, scroll to select a term.

3. To view a definition, double-click a term, or click OK, or press
Return.

4. Click Cancel or press Esc to return to the Conservatory.

11
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NOTE REFERENCE

Note Reference is a handy feature for serious students of the piano
wha need to learn more about notes, key signatures, scales, and
arpeggios. This feature is particularly useful if you are interested in
transposing music into a key other than the one in which it was
written. :

To use Note Reference:-

1. Choose Nc;te Reference on the Help menu. The Note Reference
dialog box appears. - .

=== ——— Nole Reference

EFGABCDEFGAERCDEFGABGC

¢CDEFGAECDEFGAEGCDEFOA

[Middie T — . ]

3 @ soaia @ Majar
& Octavesy ||@ Shows MiEmey || [|E Rroegsic] |3 Minsr

2. The program defaults 1o the Note butten. Click Single or
Octaves then press a note on your General MIDI keyboard, such
as C. The note you press gppears onscreen in the long display

box above the buttons and is also highlighted on the staft at the
top part of the screen. {(As shown in the example above.}

3. Click Key if you want to Hide or Show the key signature, If you -

choose Show, then you can select and view the note spellings for
the Major or Minor key signature. For example, you see “C
Major” if you press a C on the keyboard or “F Major” if you
press an F, and so on. '

4, You can also click Pattern, and set Scale or Arpeggio (a chord
breakdown) and Major or Minor.

5. Choese OK to close the dialog box, or choose Reset and OK to
restore the original default settings before closing.

12
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'USING THE SOFTWARE

This chapter explains how to use each of the six rooms that you can
go to from The Miracle Conservatory.

Click any room to open its dialog box of commands, or open its
dialog box from the Conservatary Go to menu.

To feturn to the Conservatory frem any room, choose
Conservatory from the Go to menu or press 8K.

You can also get online help from the Help and £ menus.

13
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ADMINISTRATION

When you choose Administeation in the Conservatory or from s
Go to menu, you open the Administration dialog box.

From here, you can edit or delete student records, view your
progress, and set up various system features such as keyboard and
metronome volume. Click Cancel or press Esc to return to the
Conservatory or choose one of the command buttons shown below.

To Fet online help in Administration, choose Show Help from the
Help menu, or press 8H, or choose Show Balloons from the @
meni.

The Student command opens the Edit Student dialog box. From
here you can browse The Miracle, edir a student record, or delete a
record.

To delete an exisring student record, select the name and choose
the Delete Student command. The name disappears from the
screen and the track record for that name is erased. (You may want
to back up before defeting, if you want to save progress tracking
records.)

To change an existing student record, select the name; and choose
the Edit Student command. The Edit Student dialog box opens,
where you can type corrections; and choose OK.

Note: Te add a new student, choose New Student on the File

menu. For instructions on adding a new student record, see
Enrolling in The Miracle in Gesting Started.

14
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The Miracle Setup command opens the Miracle Setup dialog box.

View or change system default settings as shown below. Choose
OK 10 confirm the changes, Reset to restore the system defaulrs, or
Cancel! to exit without changing the setup.

Page Turn - Use this drop-down field to set the automaric page
turning feature for sheet music. Next to Measures Anticipated,
accept the default 1/2, or click and drag to set the page turn to
None, 1, 1 1/2, or 2 half measures before the end of the page. This
- will affect page turns in the Classroom, Performance Hall, and
Practice Room.

Practice Room & Performance Hall Evaluations - Click this chedk
box to turn progress evaluations in the Practice Room and
Performance Hall on and off. An X in the box means that
evaluations are on {default).

Neote: Evaluadons are always on in the Classrcom.

Fade Transitions - Click this check to turn fade transitions on and
off. An X in the box means that fading is on (default) and screens
will slowly black out as you move to another room.

Neote: To speed up program performance, turn Fade Transitions off
by clearing the check box. If you are in Black & White mode, this
button will not appear.

Reset - Click the Reset button to restore the factory default
settings for page turn, evaluation, foot pedal, and velurnes.

The Hall of Fame command opens the Hall of Fame dialog box.
Click one of the Game buttons: (Ducks, Ripchord, or Aliens) to
see the top ten scores for that game by student name and song. Use
the scroll bar te see additional names, songs, or scores, as neeged.
Choose OX to return to the Conservatory,
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“The Practice Progress command opens the Practice Progress

dialog box. Click one of the Display buttons, Bar Graph or Pie
Charts, to view analysis of your most recent overall performance,
notes, and rhythm by song. Scroll to view more song names as
needed. The Legend shows the color or patterns for Song, Notes,
and Rhythm on your Macintosh graph or chart display. Choose
OK to return to the Conservatory.

The Lesson Chart command opens the Lesson Chart dialog box,
where you can see the Lessons you've started and complered for
each Chapter. Click and drag the scroll bars to view more Chapters
and/or more Lessons. Position the cutsor over a Lesson to see the
selected Chaprer name, such as Chapter 4 - Twinkle Twinkle.
Click OK to return to the Conservatory.

Set up o restore the Patch Map for your MIDI keyboard. You can
also use this feature to remap from one instrument voice to

another. For example, you can get the program to sound like a fuzz
guitar instead of a harpsichord. For details on setting or remapping

instrument patches for your version of the program, see your Quick
Start Card.

Administration Edit Menu

The Edit menu is only active when you add or edit a student
récord. When active, the commands are compatible with other
Macintosh applications. Undo is not an active command in this

program.,
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" CLASSROOM

‘The Miracle Classroom is where you will spend most of your time
learning to play the piano. In the Classtoom, you can select from
40 different Chapters. Each Chapter has multiple Lessons
organized arounfllj learning 2 particular song. A Lesson usually
involves a series of instructional Chalkboards, demonstrations, and
practices. For a change of pace, some Lessons send you to the
Arcade to play games. The end of every Lesson sends you to the
Performance Hall te play with The Miracle Orchestra. And
sometimes, but not often, you will get a pop quiz! Some
Chalkboards include highlighted Glossary words. To study 2
Glossary word, double-click it. See Glossary in The Miracle
Conservatory.

You can go ta the Classroom three ways:

+ Click the Classroom in the Conservatory. See the following step-
by-step instructions.

+ Choose the Begin Lesson or Resume Lesson command on the
Welcome screen. Same as step 2 below.

* Choose a Classroom command from the Conservatory Go to
menu.

To exit the Classroom and return w the Conservatory, choose
Conservatory from the Go to menu or press 8 K.

To get enline help in the Classroom, choose Show Help from the
Help menu, or press 3 H, or choose Show Balloons from the 2
menu. See Online Help in Geszing Starsed.

To use the Classroom:

1. Starting from the Conservatory, dick the Classroom.

17
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2. Click one of these icons:

Go to Chapter - Select from the 40 Chapters in The Miracle. In
the Go to Chapter dialog box, scroll ro select a Chaprer, then click
OX or press Return.

Resume Lesson - Return to the Lesson where you left off last time.

3. Each Chapter presents a series of Chalkboards, demonstrations,
and practice Lessons. To go to the next Chalkboard, simply play
the piano as instructed or click the available command button,
which can be:

Tusrn to the next Chalkboard Lesson.
Listen to The Miracle demonstrate the piece.
Play the piece as shown on screen.

Go to an Arcade Lesson. See also Arcade.

4, During a few Lcssons;ﬁaop quizzes test your understanding of
what you've learned. All questions are multiple choice. To answer
a question, click the answer button (1, 2, 3, or 4). If you answer
incorrectly, The Miracle tells you to try again. To try again, click
OK or press Return.

18
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Classroom Menus

Ci m menu bar inciudes the menus and active
;[;)}iunailscslfsos?mwn below. You can open all the menus and chooseh
commands with the mouse. For some commands, you can press the
command key (88) and the indicated letter without pulling down
the menn, &
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Noze: Using the Next and Previous commands will move you to a
new Lesson and not just skip the next activity in the currenth
Lesson. For example, if you don’t want to hear a demo and choose
Next Lesson, the program will go to the next Lesson in the series
and not just skip the demo.
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PRACTICE ROOM .

The Practice Roam is where you can review materials presented in
the Lessons or practice any of the pieces included in The Miracle.
You shou!d visit here often. Practice sharpens your skills so that you
can tackle more advanced Lessons,

To go to the Practice Room from the Conservatory, click the room
or select a practice mode on the Conservatory Go to menu.

To use the Practice Room:

1. Click the Practice Room or choose the command from the
Conservatory Go to menu. A Choose a Song for Practice dialog
box appears.

Soe faE haa ke EA

2. Accept the default Tempo or click the & or ¥ burtens to

decrease or increase the song speed.

3. Accept the default Hands, or click Left, Right, or both as

available.

4. Accept the default for View By (which is Chapter Level), or click
Name to view the songs by title.

5. If you have additional Seng Collections loaded, use the drop-
dewn Collection field to choose the set you want.
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6. Scroll throﬁgh the list to find the song you want. You can also
t{lpe the first letter(s) of the name to jump to a list starting with :
the

letter(s).

7. Click a song name then OK. The Pracice dialog box appears.

8. Depending on the song and hands you selected, the Practice

Room offers up to five practice modes:

Demo - You listen to The Miracle play.
Solo - You practice alone. You will hear the metronome.

Duet - You play one hand and The Miracle plays the other. If
you selected both hands in step 3, The Miracle will not give
you the option of playing 2 duet. Choose Cancel to go back

1o the Choose a Song for Practice dialog box and select either
left or right hand.

Practice Notes - You practice the piece without a thythm at
your OwWI pacc.

Practice Rhythms - You can hit any key on the keyboard as
long as you have the right rhythm. You will hear the

metronome and the correct note will sound.

Cancel - Go back to the Choose a Song for Practice dialog
box.

8. When the sheet music apglea.rs onscreen, wait for the lead beats

then start to play. When

e practice ends, you get an evaluation

unless you turned it off in the Miracle Setup (see
Administration).

9. Choose to continue... to return 1o the Practice dialog box.

To interrupt or end practice and return to the Conservatory, choose
Conservatory from the Go to menu, or press 38 K, or choose
Cancel in the Choose a Song for Practice dialog box.
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Practice Room Menus

The Practice Room menu bar includes the menus and commands
shown below. You can open alt the menus and choose commands
with the mouse. For some commands, you can press the command
key (8) and the indicated letter without pulling down the menu.
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Note: Online help is available while you choose a song; however, it
is not available during practice.
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PERFORMANCE HaALL

The Performance Hall is where you go to play with The Miracle
Orchestra.

To go to the Performance Hall from the Conservatory, click the
room or use the Conservatory Go to menu.

To play with The Miracle Orchestra:

1. Click the Performance Hall or choose the command from the
Conservatory Go to menu. A Choose 2 Song to Perform dialog
box appears (see Practice Room for an example}.

2. Accept the default Tempo or click the & or ¥ buttons to
decrease or increase the song speed.

3. Accept the default Hands, or click Left, Right, or both as

available.

4. Accept the default View by, which is Chaptér Level, or click
Name to view the songs by title.

5. If you have additional Song Collections loaded, use the drop-
down Collection field to choose the set you want.

6. Scroll through the list to find the song you want. You can also
type the first letter(s) of the name to jump to a list starting with
the letter(s).

7. Click a song name then OK.

8. When the sheet music appears onscreen, wait for the lead beats
then start to play.

9. When the performance ends, you get an evaluation, unless you
wrped it off in the Miracle Setup {see Administrarion). Click To
Continue to go to the Choose a song to Perform dialog box and
pick another song to perform.
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To interrupt ot end performing and return to the Conservatory,
choose Conservatory from the Go to menu, or press 8 K, or
choose Cancel in the Choose a song dialog box,

Performance Haill Menus

The Performance Hall menu bar includes the menus and
commands shown below. You can open all the menus and choose
commands with the mouse. For some commands, you can press the
command key (8) and the indicated letter without pulling down
the menu. o .
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Note: Onlinie help is available while you choose a ébng; however, it
is not available during a pcrfqrmance. : :
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ARCADE

The Arcade is where you go to play pra(ﬁce ames, including
Ducks, Ripchord, and Aliens. You can alse play the Jukebox from

here.

To go to the Arcade from the Conservatory, click the room or select

an Arcade command from the Go to menu.

To return to the Conservatory, choose Conservatory from the
Arcade Go to menu, or press 3 K. .

To get help, choose Show Help on the Help menu, or Show
Balloons on the ¥ menu. - : :

THg_Arcade includes these options:

Ducks - This Shooting Gallery game helps you associate keys on ’

- your General MIDI keyboard with written notes on the staff.
Ducks swim across the lines and spaces of the staff from right to
Ieft. Armed with paint bombs at the bottom, you must hit each
duck by playing the note that it swims across. If you press the
correct key, the duck disappears. If you press a wrong note, the
paint splats against the scale. If a duck disappears oft the screen
anhit, a paint bomb is used up. The number of throws per duck
varies from Lesson to Lesson. '

Nore: No marter how many ducks appear on the screen, your
bombs can only hit the duck{s) that are farthest to the left.

‘Ripchord - This game is a fun way to Ipractice chotds. A helicopter
appears pulling tE:n;hord you must play. The timer on the upper
right of the screen shows you how many seconds you have to play
the chord. Play the notes to send the parachutists on their way.

Notes that are played correctly gray out on the staff in color

systems. Play the wrong chord and — oops, the little men go splat!
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Aliens - This game is a far out way to practice fingering and
memorize note seqiences. Wait for the Alien spaceship to descend,
beam down the staff, and begin playing its notes. The next note to
play is shown two ways: as a spotlight on the Alien keyboard and as
ared trianL%le A under notes on the staff. First the Aliens play, then
you copy them. A red bar on the right side of the screen shows how
much time you have to play. If you get enough notes right, you'll
experience a close encounter!

Jukebox - You can use The Miracle Jukebox to play any song in the
program with comgzlcte orchestral accompaniment and no
metronome. See Playing the Jukebox.

Playing Arcade Games

To play an Arcade game:

1. Click the Arcade. The Arcade dizlog box appears.

2. Click a game icon {Ducks, Ripchord or Aliens!). A Choose a
Song dialog box appears (see Practice Room for an iflustration of
a similar dialog bex).

3. Accept the default for Hands or click Left or Right as available.

4. Accept the default for View by, which is Level, or click Name to
view songs in alphabetical order.

5. If you have additional Song Colleczions loaded, use the drop-
down Collection ficld w choose the set you want.

6. Scroll to find the piece you want. You can also type the first
letter(s) of the name to jump 1o a list starti_ng with the letter(s).

7. To select a song, take one of these alternatives:
. Double-click the song name.
*» Click the song name and OK.
* Press & or ¥ to select the song name, then press Return.

Note: To interrupt a game and return to the Conservatory, use the
Go to menu or press & K.

To get help, choose Show Help from the Help menu, or press 38 H,
or choose Show Balloons from the & menu.
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Arcade Game Menus

i i d active
The Arcade Game menu bar includes the active menus an
commands shown below. You can open all the menus and ::hooseth
commands with the mouse. For some commands, you can press the
command key (%) and the indicated letter without pulling down
the menu.
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Note: Online help is available while you choose a song; however, it
is not available during game play.

Playing the Jukebox

To play the Jukebox:
1. Click the Arcade room. The Arcade dialog box appears. !:

2. Click the Jukebox icon. The Jukebox appeats.

3. Click the buttons on the Jukebox to operate it as follows: ;

' i Ider from
* Open - A file dialog box opens. Choose a song fo |
thg?rop—down Songs ﬁeicF at the top of the box. You can ] :
scroll to find the piece you wanc, or type the first letrer(s) o
the name to jump to a list starting with the letter(s). Double-
click a song to open it.

* Play - Listen to the currently open song.

* A - Increase the song volume,

» ¥ . Decrease the song velume. .
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* Stop --Pause the currently open song. Press Play agam 1o
" resume. .

* Quit - Ré_l:ilm t_o the Conservatory;
Nate. You can also use the mcnu bar to 6pcrate thc Jukebox. Sce
Jukebox Menus,

To get hélp,’ .choose Show Balloons from the # menu.

Jukebox Menus

The Jukebox menu bar includes the active menus and active
commands shown below. You can open all the menus and choose
commands with the mouse. For some commands, you can press the
command key (38) and the indicated letter without pulllng down
the menu.
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. STUDIO

‘The Studio is where you go to record and play back your own
music. This feature works like a tape recorder with 7 or 8 tracks
instead of 1 or 2. With it, you can record up to eight instruments,
one at a time, then play them back together. You can record any

- song in The Miradle or record your own versions of other songs.

" Note: This feature does not replace sequencing software. For serious
recording, purchase a sequencer. '

To go to the Srudio from the Conservatory, click the room or
choose Studio from the Go to menu. The tape recorder appears. Y

. Tia Tt saeg drzoaped Felo Fale

To exit this room and return to the Conservatery, choose
Conservatory from the Go to menu or press # K.

To get help, choose Show Help from the Help menu, or press 3 H,
or choose Show Balloons from the ¥ menu.

To record or play back a song:

1. Record your own song by choosing New Song from the File
menu, or add arrangements to a song from The Miracle by
choosing Open Song from the File menu. See Opening 2 Song.

2. Use onscreen buttons to set tempo or volume, and 1o select _
instrument tracks for recording or muting. : j
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3. Use the Song menu to tura the metronome on or off.

4. Use onscreen buttons and/or the Transport menu to record and
play back a song,

5. Use Save As... on the File menu to save your performance. See
Saving a Song.

Before you start, take a minute to review the Studio’s buttons and
menus. See Tape Recorder Buttons and Siudio Menus.

Tape Recorder Buttons

You can click tape recorder buttons to set the tempo, instrument
tracks, muting, and volume, and to operate the tape recorder as
shown below. You can also use the mouse to choose Song and

Transport menu commands to do the same chings. See also Szudio
Menus.

‘These tape recorder buttons correspond to the commands on the
Transport menuw:

|- Click this button to stop a recording or playback session
and rewind to the beginning of the song.

<4« Click this button to stop a recording or playback and
rewind part of the song.

B Click this burton to stop the recording or playbacle. If a
recording was in progress, the music is saved, the record track is
changed, and the deck is rewound.

» Click this button to play the currently ioaded song.

- Click this button to fast forward through a song. This may
be done during playback.

® Click this button to record music and save it for later
playback. All non-muted tracks play during a recording session,
except the record track,

Some of these tape recorder buttons correspond to the commands
on the Song menu:

* Tempo - At the left of the screen the tempo arrows set the speed
of the song in beats per minute for recording and playback.
Click & or ¥ to increase or decrease the tempo. Thc tempo
appears abave the arrows.

* Clock - Below Tempo is a digital clock that shows the minutes
and seconds you are into playing a song.
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+ Instrument Tracks - In the middle of the screen the 8 long
rectangular bars are the instrument tracks. Point to a bar to
choose from 127 instruments in numeric order. You can record
up to cight different instruments for a song on rracks 1-8. If the
song is stopped, you will hear a chord with the instrument -
sound you select for that track. s

Note: Track 8 is normally reserved for the metronome. To record
on this track, be sure to turn the metronome off on the Song
menu.

* Mute - Next to each instrument track is a large square, which is
that track’s mute burton (turns the sound for 2 track off or on).
Each mute button that is lit does not let you hear music on. that
track during recording or playback. Click mute buttons to turn
muting on and off for each track.

* Record Track - Next to each mute butron is a small square,
which is that track’s record button (turns the recording for a
track off or on). To record music, you must select one track ara
fime. If you want to record more than 1 insttument, then several
tracks need to be recorded, one ar time. You can only record on a
track that loads an instrument patch and on the first blank track
following already recorded tracks. Click record buttons to turn
recording on and off for cach track.

Caution: Recording on a track erases any previous music, so be
careful not to erase a track you want. The only way to recover an
erased track is 1o reload the song if it was saved.

* Volume - At the right of the screen click and-drag the scroll bar
to adjust volume from 0-10. Volume 0 can be heard very sofily.

Studio Menus

The Stadio menu bar includes the menus and active commands
shown below. You can open all the menus and choose commands
with the mouse. For some commands, you can press the command
key (38) and the indicated letter without pulling down the menu.

Note: The Song and Transport menus are alternatives to clicking
some of the tape recorder butrons.
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Opening a Song

You can open songs shipped with the program or songs that you
have recorded.

To open a song:

1. Choose O%en Song from the File menu. A standard Macintosh
file dialog box appears,
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2. Choose a folder from the drop-down Songs field at the top of
the box; then click the Open button to view the song list.

3. Select a song and click the Open button again. As soon as the
song is opened, its name lights up on the tape recorder.

Saving a Song

Important Note: Writing over the existing song files is not
recommended as The Miracle Lessons may not opetate properly.
When you save a recording, you should give it a different name
from The Miracle song and put ir in your own folder.

To save your own recording:

1. Choose Save As... from the File menu. A standard Macintosh
file dialog box appears with the highlight on the song name.

GF ve EE Sain epsh medull duld R e

2. Type the name that you want to use for the recording, then click
the drop-down field at the top of the screen to select your own
folder. {As needed, use the dialog box to locate the folder where
you placed it on the deskrop, then use the drop-down list.)

3. Clidk Save.

The next time ydu want to change the recording, select it from
your own folder rather than from the original song folder.
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Recording Multiple Tracks

Ta record multiple cracks:
1. Go to the Swudio.
2. Use the Tempo buttons to adjust the beat for the song.

3. Select a track. The defaulr is Track I; to select another track, .
click its Record burton. :

Example: To selecr Track 2, click its Record button.,

Note: If you want to change the instrument for this track, point to
the track bar then select an instrument from the list.

4. Click @ to begin recording your performance.

5. After the fourth metronome tick (lead beats), start and play uneil
you are done with the track,

6, When you finish playing, take ene of these options:

* If you made mistakes, click |+ to rewind to the beginning,
discard the recording, and try again. Repeat Steps 4 and 5.

+ Ifyou are satisfied, click B to stop and save the recording on
that track. To record more tracks, repeat steps 3—5 unti you
finish recording tracks.

7. When you are done, save the recording, See Saving 2 Song.

Erasing a Track

If at any time you decide that you don’t like a track and want ro~
erase it:

1. Click the instrument track that you want 1o erase.
2. Click @ (Record).
3. Without recording anything, click ¥l (Stap).
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THE THEORY
BEHIND
THE MIRACLE

The Miracle Piano Teaching System is the first compurer
program that teaches you how to read and play music on the piano.
It does this by providing interesting activities and games that build
your knowledge and playing skills step by step. If you've been
through The Miradle course, you're familiar with how this works.

But what happens inside The Miracle Piano Teaching System?
This chapter describes the inner workings of the software and how
The Miracle seems to “know so much” about piano playing.

The Miracle teaches piano in hundreds of small steps called
Lessons, which are grouped inte Chapters. One Chaprer, for
example, introduces rthythm. Another Chapter introduces staff
notation (how music is written).

These Chapters are arranied to give you basic skills first, then to
%Vnﬁrove on these skills while introducing more advanced conceps.

en you successfully complete a Lesson, you go on to the next
Lesson in that Chapter. When you complete the last Lesson in a
Chapter, you go on to the next Chapter.

But what happens when you dont get through a Lesson the first

time?

Human piano teachers watch you practice. If you don't ger through
a Lesson ﬂroperly, the teacher gives you special exercises to help you
get over the problem.

The Miracle does the same thing, It “listens” to how yon play, then
analyzes your performance. If you had problems, it too creates a
special exercise to help you overcome those problems.

The Miracle analyzes your playing both during the performance
and afterward.
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During yaur performance, The Miracle listens to make sure you
are playing the right notes at the right times.

The Misacle also records your performance for later analysis. It
records which keys you press, when you press them, how hard you
press them, and when you release them. The Miracle calls this
data the AMS, or Actual MIDI Stream.

When you finish playing, The Miracle compares your AMS with
its IMS, or Ideal Music Stream. This is its recording of how the
performance is supposed to sound.

. When you play the piece incorrectly, it is not enough for the

program to say,  Well, you played some notes wrong,” The goal of
an expert teaching system is to determine why you played the notes
wrong, then offer corrective measures. : :

The Miracle classifies each of your errors as one of 200 error types.
These types are sorted into 41 main categories. Some examples of
the main error categories are:

¢ Ignoring an g(':cidental mark
. __Holding a note too -lbng

+ Playing the notes too fast

' . Mjsundersté.nding the previous accidental rule

:* Ignoring a rest

* Not holding a dotred note long enough
» Striking the crack between two keys
Because different Lessons develop different skills, The Miracke pays -

. particular attention to the error categories associated with those

skills. For example, when evaluating a Lesson that focuses on

- thythm, The Miracle is less piclky about a few wrong notes than it

is abour bad rhythm.

" 'The Miracle determines which categories are important by

assigning an importance value or weight to each of the 41 error
categories for that Lesson. The more important the error, the
higher the number.

Bach caregory’s weight is then multiplied by the percent of mistakes
made in that category. This creates a score in each of the 41 error
categories.
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Low scores mean you made few mistakes. If your scores are low -
enough, The Miracle gives you a passing grade and takes you to -
the next Lesson, Otherwise, The Miracle identifies your most
significant error (the one with the highest score), and designs an
exercise 1o help you overcome this problem.

Each of the 41 error categories has a half-dozen or more exercises
that can help you overcome a problem in that category. These
exercises use The Miracle’s various Activities, such as Shooting
Gallery, Rbythm Practice, and so on.

When The Miracle chooses an exercise, it first ¢liminares any
exercise for the category that is not appropriate to the Lesson. For
example, if you haven’t learned how to play with both hands yet, it
won't ask you to play with both hands.

From the remaining exercises, The Miracle then sclects the one
that uses the least recent Activity. For example, if you have a pitch
error, you'll get a Shooting Gallery exercise. In this way, you
constantly work in a variety of Activities.

Once the exercise is selected, The Miracle creates a Chalkboard -
screen that tells you what tgour error was, and what exercise you'll
do to work on it. It does this by combining two pieces of texc:

¢ The first comes from a phrase list associated with each error
category; it tells you what you did wrong,

* The second comes from a phrase list associated with the Activity;
it tells you what 1o do to correct the problem. '

The two phrases are combined using common rules of English.

Your performance in the exercise is analyzed in much the same way
as your performance in the Lesson. If you receive a passing grade,
The Miracle returns you to the Lesson where you had the problem.
If you make many mistakes in the exercise, The Miracle creates
another practice exercise.

As you work with these exercises, your skills gradually improve.
Eventually; you will be able to get through the initial Lesson and
move on to the next.
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GETTING
THE MOST FROM
THE MIRACLE

w ith a little patience and regular practice, you'll soon be
playing the pianc. The Miracle helgs you every step of the way,
with Lessons that make learning and practicing every Chapter fun.

COMPLETING A CHAPTER

At first, you'll want to do as many Chapters as you can. Thart’s
okay, but it’s best to complete one Chapter’s Lessons before going
to the next Chaprer. Try using The Miracle like this:

1. Complete a Chaprer.

2. Go to the Practice Room and play all of that Chapter’s pieces
until you can do them well.

3. Redo the Chapter, to be sure you got it. If you practiced
enough, the second time won't take long,

4. Go on 1o the next Chapter.

Later in the course, expect Chapters that take a week or more to
complete. These Chapters are more challenging to sharpen your
skills. They take time to master, so don' get discouraged. With
practice, you'll get it!
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PRACTICE MAKES PERFECT.

To get the most out of The Miracle Lessons, practice a little every
day — 45-60 minutes is ideal. Even 15 minutes is berter thar no

- practice at all! You'll learn to play sooner by practicing regularly.

When you can't get through a Lesson, you may think “Tll never ger
this!” This happens to everybody, and just means that it’s time for
a rest. Play some music you already know, or stop for awhile.
Remember, you will get it eventually. -

The Practice Room

Use the Practice Room. There you can work on more challenging
pieces, rather than just repeating Lessons. With all of The Miracle’s
Activities available, you can practice many ways. For example, if
you're having trouble with the right hand notes in a song, select
Right Hand practice and work in either the Shooting Gallery or
Practice Notes. If you're having trouble coordinating both hands,
select Borh Hands practice and work in Practice Rhythms,

The Practice Room has many pieces that are not in the Lessons. To
learn any piece using onfy the Practice Room:

1. Learn the left hand rhythms.

2. Learn the left hand notes.

3. Play the entire left hand part.

4. Repear this 3-step procedure with your right hand.

5. Repeat it again with both hands.

When learning thythms, use Practice Rhythms. If you make too
many mistakes, just start again. Or, try [istening to the thythm of
the piece by selecting Demo.

When learning pitches, use the Shooting Gallery at first. Take all the
time you need, and try to temember the rhythms you already

learned.

If you have trouble playing the entire part, go back to Prectice Notes
or Practice Rbythims,

SPECIAL NOTE TO PARENTS

The Miracke Piano Teaching Systemn Software works with children
ages eight and up, but pre-teens may need help reading lessons, or
leatning to position their fingers on the keys.
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This is a great way for you 1o get involved with your child’s piano
playing. If you don't know how to play piano, you might enjoy
taking the course along with your child. You'll both find it

‘rewarding to learn a creative skill cogether.

" Children make the best progress when practicing is fun. To
convince your child that practice is fun, show an interest in his or
‘her progress during and after practice. Your excitement about the
child’s progress can really inspire him ot her to continue. This is
especially E.m for everyone in activities where The Miracle
accompanies your child’s performance.

SPECIAL NOTE TC TEACHERS

The Miracle can enhance your teaching with practice exercises that
are possible only on a computer:

* Pointers - Give visual whar to play cues that builds music reading
confidence,

« Pitch Practice Activities - Advance pointers to new netes only
when you play the correct pitch.

» Properly Adjusted Metronome - Continuously reinforces good
rthythm.

o Rhythm Practice Activities - These play the cFroper pitches no
matter what key you press. This lets the student actively
participate in partially demonstrating the piece.

* Shooting Gallery - Makes practicing fun while developing note
reading and rhythm skills.

o S;])_‘ecial Fxercises - Help students overcome specific problems.
These are given as needed, when The Miracle detects error
trends in a practice session.

o Different Display Formats - Provide variety and help students
focus on specific aspects of a piece.

* Practice is constantly varied and fun - Students tend to practice
more — and regularly!

As the teacher, these tools can effectively speed your students’
progress. This gives you time to focus on:

» Maintaining good hand position.
¢ Phrasing and tapering of phrases.

+ Rubato or subtleties in the tempo.
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NOTE TO EXPERIENCED PLAYERS

Experienced piano players often find The Miracle course a
wonderful way to refresh their memories and improve their
playing skills. Also, since The Miracle is designed to teach music to
beginners, experienced players can zip through the initial Lessons.
Complete the first two Chapters, to see how the system works.
Then skip ahead as far as you want.

The interactive nature of The Miracle lets it teach piano using
unique, new techniques that only a computer can provide. You'll
find learning with it quite different from a course presented by
traditional instructors, although all of the standard elements are
there. These elements are sometimes presented in a different order
than they are in standard courses. As a result, you might find an
occasional Lesson that covers things you already know.

42



" . HISTORY OF THE PIANO.

HisTORY OF
THE PIANO

In the Pidgin trading language of New Guinea, the piano is called
“3 box of music with teeth like 2 crocodile, suppose you fight it
hard, it cries out.” Amazingly; this accurately describes the piano’s
earliest ancestor.

PiPE ORGAN

The piano’s earfiest ancestor is the organ, which was invented in the
3rd century B.C. by the Greek engineer Ktesibios. His Hydraulos
was the first keyboard instrument. The wooden “keys” looked like
tongues and worked like hydraulic pumps. Key presses used water
pressure to force air thougg ipes, which made sounds. This was
not easy. Hydraulos players had 1o pound keys with their fists to
fight the water pressure!

Pipe organs with easier actions appeared around the 6th century,
and quickly became the favorite instrument of The Church. They
ate still popular there today.

CLAVICHORDS

The davichord was the first keyboard instrument that used strings
instead of pipes. Invented during the Middle Ages, the clayichord
became popular in the 1400s. Key presses moved flattened brass
pins against brass strings that vibrared when struck. The pressure
on the keys controlled the volume; however, at its loudest, the
clavichord was as quiet as a mouse.

This made the clavichord ideal for home practice and the
instrument of choice in nunneries. Nuns loved it, because they
could play without disturbing those around them.

43



THE MIRACLE® PIANO TEACHING SYSTEM SOFTWARE |

HARPSICHORDS

An Tralian, Giovanni Spinnetti, was less impressed. He wanted a
more powerful instroment that made louder sounds. To increase
the volume, Spinnerti made the soundboard and strings longer.
On his harpsichord, key presses firmly plucked strings with quills.
This made the loud sound that Spinnetti wanted, but there was no
way to quict it down!

ORCHESTRAS

During the 16th century, orchestras appeared with harpsichords as
standard instruments. Performances Ig)y early orchestras were either
private affairs for royalty, or associated with a new musical form
called opera.

Although keyboard music became popular, few people owned
keyboards. Because harpsichords an clavichorci were
complicared, hand-made instruments, they were quite expensive.
Royalty and wealthy peopled displayed them proudly, but they
were rarely seen elsewhere, Music was an art for the rich.

PUBLIC PERFORMANCES

Public performances by individual musicians were untheard of until
1672. That year an English violinist, John Bannister, realized there
was money to be made from them. At 4 o'clock every afternoon,
Bannister charged “a shilling a head” for anyone who wanted to
come to his house and listen to musicians.

Keyboardists introduced themselves to the public in 1678 when
another Englishman, Thomas Britton, rose to fame holding
concerts in the loft above his coal store. Handel (best known today
for his Messiah} was one of many who performed on the
harpsichord in Brittor’s well-heated loft. Here is an early ad for
these performances:

"ANYBODY THAT IS WILLING TO TAKE A HEARTY
SWEAT MAY HAVE THE PLEASURE OF HEARING MANY
NOTABLE PERFORMERS IN THE CHEERING SCIENCE
OF MUSICK”

By the early 1700s, public performances were common, and the
harpsichord’s volume made it the logical keyboard instrument ro
play. This frustrated many composers, who wanted subtle volume
variations te express their music. In fact, Johann Sebastian Bach
publicly called the harpsichord a “souliess instrument.”

What the world needed was an instrument that combined the
harpsichord’s volume with the clavichord’s expressiveness.
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THE PIANO IS BORN IN ITALY

In 1709, the piano was born. The inventor; Falian harpsichord
designer Bartolommeo Cristofori, called it the Gravicembalo Col
Piano E Forte (Harpsichord with Loud and Soft).

The Pianoforrte, as it was known, used hammers and dampers to
control the strings. A key press threw a small wooden hammer up
against a string, making it vibrate. A hard key strike struck the
hammer bard, making a loud note. A soft key strike struck the
hammer softly, making a quieter sound. When the key was
released, a damper fell on the string, silencing it. This is essentially
how pianos work today.

Cristofori was excited about his invenrion, Unfortunately, no one
else seemed to be. Despite the piano’s advantages, the harpsichord
continued to dominate the musical world.

GERMAN PIANO MANUFACTURING

A German organ maker, however, was excited by Cristofori’s
hammer action design. In 1725, Gottfried Silbermann began
copying Cristofori’s piano and promoting it throughout Germany.
But he too fought an uphill battle to get it recognition.

In 1736, Silbermann tried to promote the design by introducing
his piano to one of the harpsichord’s harshest critics, the great
Johann Sebastian Bach. Sifbcrmann had high expectations as Bach
played the instrument and considered it.

The famous composer agreed that the piano had a pleasant tone,
but declared that the treble was too weak and the action too stiff.
This infuriated Silbermann, who refused to speak to Bach for many
years.

Eventually, Silbermann improved the features of the piapo that
Bach criticized, By 1747, 11 years after his introduction to it, Bach
said the piano was “coming along.”
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FIRST PuBLIC CONCERT -

The first public concert featuring a piano was held in 1767, 58
years after the instrument’s invention. An ad promoted the concert
as a benefit by a *Miss Brickler,” who sang while accompanied “on
a new instrument called a Plano Foree.”

Although the piano was well received at the Brickler concert, it was
a performance in the following year by Johann Christian Bach (the
youngest son of Johann Sebastian Bach) that finally brought the
instrument public acceptance. Suddenly, pianos of numerous
designs appeared all over Europe and the New World. Future
American President, Thomas Jefferson, an extraordinary violinist
and passionate music lover, bought a piano in 1771.

MORE PIANO MANUFACTURING

At this time, the largest manufacturers of pianos were the French,
led by Sebastien Erard, and the English, led by John Broadwood.
French pianos were known for their crisp, delicate touch, while the
English pianos were known for their fulgmess of sound. The virtues

of each were a topic of many arguments among composers in the
late 1700s.

The first American piano factory opened in Philadelphia in 1774,
manufactuting instruments in the English design.

MOZART

Around that same time, the fame of an amazing keyboard
performer was spreading across Europe. Wolfgang Amadeus
Mozart was a child prodigy of exceptional talent. When the child
began composing music at age four, his father realized there was
money to be made. By age six, Wolfgang was paraded past rhe
royalty of Europe, stunning them with his perE)rmanccs.

At age 14, Mozart was so skilled thatat a single exhibition, he was
challenged to play the following:

“a Symphony of his own composition; a harpsichord concerto
which will be handed to him, and which he will immediately play
prima vista {on first look); a Sonata handed vo him in like manner,
which he will provide with variations, and afterwards, repeat in
another key; an Aria, the words for which will be handed to him,
and which he will immediately set to music and sing himself,
accompanying himself on the harpsichord; a Sonata for
harpsichord on a subject given to him by the leader of the violins; a
strict Fugue on a theme to be selected, which he will improvise on
the harpsichord; a Trio, in which he will execute a violin part all’
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improvviso (improvised); and finally, the latest Symphony
composed by himself.”

Mozart met the challenge and the concert was a success.

Mozart was another composer who disliked the limits of the
harpsichord. Unlike Bach, he embraced the piano, making it a

serious professional instrument.

-With the piano’s endorsement by Mozart and his contemporaries,
pian teachers soon found themselves in demand. By 1779 in
Vienna, over 300 piano teachers were making a comfortable living,

BEETHOVEN

In 1787, a 31-year-old Mozart heard a performance by a young
prodigy, the sember but brilliant Ludwig van Beethoven.

Mozart was never easily impressed. He correctly believed that few,
if any, composers wete even close to being his equal. Of the 17-
year-old Beethoven, however, he claimed “This young man will
leave his mark on the world.”

Not everyone agreed with Mozart. Seven years later, when
Beethoven studied counterpoint with Johann Georg
Albrechtsberger, the famous Viennese instructor insisted that
Beethoven “has learned nothing, and will aever de anything

properly.”

Albrechtsberger was frustrated because Beethoven's active
imagination distracted him from the dry, traditional course of
study. This imagination, however, was Beethoven’s strength, and it
made him one of the greatest composers in the world. To him,
music was just a puzzfe to be solved. His imaginative solutions
yielded works of great power and expression, often built from
seemingly dull themes. In fact, Beethoven’s performances were so
powerful that he hired musicians to run around the piano and
remove the strings and hammers thart he broke.
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PIANO FRAMES

Then again, Beethoven’s performances had to be powerful.
Concert halls were getting bigger and outgrowing the carrying
power of 18th century pianos. Although manufacturers knew that
thicker strings would increase the piano’s volume, the 16-ton
tension required to tune such strings would snap a wooden piano
frame like a twig. o

A Bostonian, Alpheus Babcock, solved the problem in 1830.by
making a cast iron piano frame. Within a few decades, his design
revolutionized rthe industry. A variation of Babcock’s cast iron
design is still standard in today’s pianos, in which the thicker

strings require tensions of aver 30 tons!

RUSSIAN SCHOOL

Babcacl’s design helped the rise of pianists such as Anton
Rubinstein, a Russian known for thunderous performances, In
Europe, most critics wondered at all the fuss, since Rubinstein
often played sloppily, boiwching notes during his energeric recitals.
Audiences, however, loved the energy of Rucbinstein’s performances,
and left his concerts feeling well entertained. Today Rubinstein is
remembered as the founder of the Russian School of piano playing,
which emphasizes fiery performances and virtuosity.

Another exciting performer was Franz Lisze, whose handsome
features, ur.mrivale(iI skill, and dramatic playing style got the same
response from the women of his day that the Beatles got from their
fans in the 1960s. Women charged the stage, throwing jewels and
shricking in ecstasy. A fight always broke out over the green gloves
that Liszt left on stage after the performance. One woman
supposedly fished through trash for a cigar stub thar Liszt smoked,
then cargied it in her bosom until she died.
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CHOPIN

Although Liszt was the most popular pianist in Europe, another .
composer; Frederic Chopin, had a greater impact. Co

Chopin was a small, foppish man to whom social circles and proper
fashion meant everything, Although lacking Liszt’s personal '
magnerism, he amazed audiences by playing with a grace and
agility that seemed impossible to achieve with his finy, delicate
hands. Today, Chopin is remembered as the pioncer of a style of
music, called Romanticism. This form, \-‘VhiCE is still popular
today, concentrated on the emotional aspect of music instead of the
technical, and often abandoned the rigid forms imposed by the

~ earlier composers. : S _

THE STEINWAY PIANO

As music changed, so did the piano. In 1836, German cabinet
maker Heinrich Steinweg of Steinway & Sons built a piano in his
“kitchen, which combined Babcock’s cast iron frame with the recent

English notion of pedals and the hammer action improvements
made by the French. It was the first modern piano, and the
beginning of the most prestigious piano manufacturer, Steinway &
Sons.

-Tn 1853, Steinweg moved his business and family to New Yotk,
where it remains today. By this time, piano playing had spread like
wildfire, and the instruments were everywhere. They were even
common in the rugged American west, where piano players
appeared in dance halls, bar rooms, and bordellos.

AMERICAN PIANO

By 1870, there were over 7,000 piano manufacturers in the USA
alone, with manufacturing production increasing almost twice as
fast as the population. Over the next 20 years, one out of every six
Americans was involved in the piano industry:

During this time, manufacturers began experimenting with
stranger and stranger variations on ﬁleir designs. Inventors did"
anything to appeal to the public’s piano obsession. Some of these
pianos were round. Others were square or wing shaped. Still
others stoad upright. Some had keyboards on each side so that
several pianists could play at once. The Janko piano keyboard
Jooked like a typewriter. And Emil ]. Cost made the smallest
working piano in the world, measuring 1/2” x 3 3/87 x 6 1/2” —
about the size of a short paperback book!

49



THE MIRACLE® PIANO TEACHING SYSTEM SOFTWARE -

Pt AYER PIANO

The most unique of these inventive pianos required no pianist.
The player piano could duplicate a performance by rolling a hole-
punched sheet of cardboard past a line of air jets. Each hole was
one note of the performance. As a hole passed a jet, air shooting
through it fired the appropriate hammer ar the piano’s strings.

These player pianos accurately recorded many aspects of a
performance, including dynamics and pedal activity. As a result,
surviving player piano rolls provide us with accurate recordings of
performances that were played long before the advent of modgesm
recording equipment.

RAGTIME

JAzz

A wide variety of music was available for player pianos, but the
most popular of the day was a new style of playing called Ragtime,
which stood for ragged time. Ragtime tunes, called Piano Rag,
were highly syncopated pieces that favored fast tempos and a more
staccato flow.

As a result of Ragtime, the piano’s popularity increased more than
ever. By the turn of the century, almost 365,000 pianos a year
rolled out of factories. The stranger designs mostly disappeared,
Jeaving pianos primarily in the form of either wing-shaped Grands
or Uprights. The Grand piano produced louder and superior
sounds, so was used for concert. performances. The Upright's
imaller footprint, however, made it the piano of choice for the
ome,

The Upright was also the favorite of artists in another new style of
music, Jazz. This uniquely American form had its roots in both
Blues and Ragtime. Unligc these single instrument styles, however,
Jazz was played by small bands, usually with a piano, a coronet, a
trombone, and a bass,

The thing that made early Jazz most unique, however, was thar it
was rarely written down. Few Jazz musicians could read music.
Instead, these musicians depended on their skill, intuition, and
experience. The Jazz age heralded a return to the art of
improvisation which, though applauded in Mozart’s day, was -
trowned upon by the classical performers of the late 19th century,
and is still uncommon in classical performances today.
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ELECTRIC PIANO

The early 1950s saw the most unique addition to the piano since
the cast iron frame — electricity, This addition was first made by
the Wurditczer Company. With it, the era of portable pianos had
arrived,

In an electric pianc, the hammers strike metal reeds or rods whose
vibrations create electrical signals. These signals are then sent 1o an
amplifier and a speaker which reproduces them as sound. The
sound, however, is somewhat different from that of a traditional
piano. As a result, the electric piano found a home in new, rather
than classical forms of music.

MOOG SYNTHESIZER

While the electric piano was sparking interest, German inventors
and composers were learning to produce sounds by entirely
¢lectronic means. They useg a dzvice called an oscillator, which,
when coupled with a keyboard by Robert Moog in 1965, formed
the first synthesizer.

Using this Moog synthesizer, composer Walter Catlos created the
1969 album Switched on Bach. Bach’s music lent itself
magnificently to the unusual sounds of this new keyboard
instrument. The result legitimized the synthesizer while
introducing the works of the baroque period’s greatest composer to
a new generation.

SOUND SAMPLING

Synthesizers have made enormous advances since the early Moogs.
Alchough today’s synthesizer can still make unique electronic
sounds, it can also accurately reproduce the sound of man
traditional instruments, This is gone by a process called sampling,
The process starts by making a digital recording of notes played by
a realp instrument. Using computer technology, the soun(f is
converted into a series of numbers, which are later converted back
to sound. Compact Discs also work by the same process.

In synthesizers, these numbers are stored in a computer chip rather
than on a disc. When the keyboardist plays a note, the synthesizer
converts the numbess for that note back into sound. The result is
the exact sound of the instrument that was originally recorded. By
the early 1980s, computer technology was also being used to atiach
sequencers to electronic keyboards. Performances were digitally
recorded, edited or averlayed wich additional musical sequences,
then played back through the synthesizer. Unfornately, each

manufacturer’s sequencer only worked with it own synthesizer,
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MIDI

In 1982, representarives of the tof synthesizer ma.nufactu.rcr_s met
to discuss this compatibility problem. The result was MIDI

. {Musical Instrument Digital Interface), which became the standard

tormat for sending data between instruments and sequencers (ot
other instruments),  MIDI is so versatile that it is also used to
conrol stage lighting, special effects, and video equipment. All
manufacturers, including The Miracle’s, support the MIDI
standard today. ' :

* The cembination of san.lp'liug and MIDI changed the way mé.ny

composers work. Making a recording no longer requires dozens of
musicians, a studio, and a room full of recording equipment. A
single composer with a sequencer and a keyboard can create the
sound of everything from a rock band to 2 symphony orchestra, To
do this, the composer uses the synthesizer to create one instrument
sound at a time, then sequences all sounds together. In fact, most
of today’s movie soundtracks are created in éxactly this manner.

MIDI keyboards are aiso a boon to Rock musicians, A keyboardist
can replace an entire wind, brass, or string section, [froviding an
instrumentation range once impossible te create in live Rock
performances. In addition, some bands use sequencers to help
them perform songs that normally require many more musicians.

THE MIRACLE

In The Mifade Piano Teaching System Software, you'll use 2
synthesizer to learn an instrument with a rich 300-year tradition ...

~ the piano.
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" WHERE TO GO FROM HERE:

WHERE 17O GO
FroM HERE

Congratulations! You've finished The Miracle Piano Teaching
System Software and mastered the basics of an exciting skill. You
have every reason to be proud!

You now know how to:
* Recognize commonly found symbols in piano sheet music.
* Read and play notes, thythms, and fingerings for a piece.

+ Separate pieces into smaller sections and parts, such as pitch and
thythm.

* Cocrdinate changing keyboard positiens and chords.

*» Blend notes using the pedal.

Now, continue your training by learning pieces on yout own,
Scleciﬁ)ieces that interest you and try to practice daily. Your skills

in both playing and sight reading will continue to improve.

Praciice the way you did with The Miracle for 45 minutes to an
hour each day. Don't forget that playing for even a few minutes is
better than not playing ac all.
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SELECTING NEw PIECES

Visit your local music store, browse through the sheet music
section, and choose some music that you like. Here are some
guidelines.

Consider trying some of the following:

General

» Scott Joplin piano rags
. Spirimalpand Gospel arrangements

Contemporary

+ Folk music collections

* Movie soundtracks

* Popular songs

* Rock collections, such as The Beatles, Elton John, and Billy Joel
* Beginning Jazz collections

Classical

* Bach’s 2-Part Inventions

* Bartok’s Mikrokosmos

* Schumann’s Kinderszenen

* Sonatas and sonatinas by Clementi, Kuhlau, Haydn, and Mozart
* Easy pieces by Grieg

GETTING FURTHER INSTRUCTION

In addition o practice, you can further your studies by taking
piano and/or music theory lessons through group classes or private
nstruction.

Group Piano Lessons

Group lessons are an excellent way to continue from The Miracle
course. Iy your local Parks & Recreation departments, community
programs, adult education programs, and community, state, and
private colleges.

Private Piano Lessons

There is no substitute for a good piano teacher to improve your
playing technique, glhrasing, dynamics, rouch, musical seyle, and
interpretation. With a good teacher, you'll learn different styles
and more difficult pieces. Many piano teachers include theory
lessons in their training programs. Playing in public is fun and
exciting, and with 2 good piano teacher you'll get a chance 1o do
recitals, competitions, and other performances.
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To find a good teacher, contact the music department in a nearby
college and ask for a list of qualified music teachers in your area.

Theory Classes

Mausic theory teaches you the underlying concepts behind music
and how it is put together. Among other things, you'll learn about
the formation of chords and chord progressions.

Rock and Jazz musicians need music theory because they must
improvise as they play. Classical pianists use it to recognize
patterns in complex pieces. If you want to compose music, theory
is invaluable.

Theory classes are also offered through community programs, adule
education programs, and community, state, and private colleges.
Prices vary.

If You're Interested in Playing Jazz

A private instructor is your best bet for learning Jazz and
improvisation. Again, your local college is a good source on where
to find a qualified instructer. If you want to %eam Jazz, music
theory is invaluable.

If You're Intetested in Playing Rock

Keyboardists are in demand by Rock bands. If you're interested in
Rock, learn about improvisation, Blues, and Jazz. Make up stuff
you like and play it. Listen to other Rock keyboardists to get ideas
and discover difjf{erent styles of playing. Copy styles you like while
you develop your own.

Playing With Friends

Playing music with your friends is a fabulous, fun way to Jearn any
style of music you choose. There is a wide range of classical
material for piano and one or two other instruments, and a rich
repertoire for Jazz and Rock bands.

Playing in a group increases your confidence, improves your sight
reading, develops your rhythm skills, and introduces you to new
challenges and material. Most importantly, you'll get excired about
practicing with your friends.
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LISTENING TO MUSIC
If you want to be a musician, the best thing to do is listen to a lot
of music. Choose music that you like, for piano or for groups and
orchestras. :

Here are some music artists you may want to consider;

The Doors

Joe Jackson
Billy Joel

Elton John
Jerry Lee Lewis
Talking Heads
Tori Amos

Jazz

Biil Evans

Oscar Peterson
Arc Tatum
Teddy Wilson
Keith Jarrett
Herbie Hancock

Bach Mazart
Beethoven Prokofieff _
Brahms Rachmaninoff
Chopin Ravel

Debussy Scarlatti
Gershwin Schumann

Liszt Tchaikovsky

Friends and record store employees can also offer suggestions.
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Accidental

Bar

Bar Line

Baroque

Bass Clef

Bass Line

Bass Staff

Béam

Beat

GLOSSARY

.GLOSSARY

A note that appears in staff notation preceded
by a sharp, flat, or natural symbol.

See Measure.

The vertical line thac separates measures in staff
notation. '

A period of musical history which lasted
from abour 1600 cthrough 1750. Notable
composers of this period include Bach,
Couperin, Handel, Pachelbel, and Scarlarri.

The symbol ar the left edge of a staff that
identifies it as a bass staff. Sometimes called an
Fclef because it indicates that the note on the
second line of the staff is an £

The notes played on the bass staff (in piano,
these are usually, but not always, played with the

. left hand).

A staff that begins with a bass clef, whose note
pitches are normally associated with the male

~ voice and low-pitched instruments. On the

piano, it is associated with the Ieft half of the
keyboard.

- A thick line that connects the stems of two or

more consecutive notes with durations lasting
an eighth note or shorter. It is used to simplify
notation and improve readability of rhythm

information.

A short interval of time, used to keep rhythm.
Each measure of a piece is made up of a fixed
number of these beats. When using a
merronome, one click is usually associated with
one beac,
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Broken Octaves

Cembalo

Channel -

Channel Map

Chord

Clef

Coda

Commeon Time

Compound Time

Contrapuntal

Contrary Motion -

A musical pattern in which notes alrernate back

and forth between octaves. This partern is
normally found in the bass line.

Harpsichord.

An electronic band or frequency. MIDI has 16
channels. You can send a different voice (patch)
to each channel,

List of channel patch assignments for the
current musical output device.

Two or more keys pressed at the same time.
2-note chords are sometimes called Double
Notes, Chords are wrirten as several note heads
attached to one stem.

A symbol that appears at the left of each staff to
indicate what notes the lines and spaces of the
staff represent. Two types are used in piano
notation: treble clef and bass clef.

The finale of either a piece or major section of a
picce. In order to create an impression of
finality, codas generally use a pattern of notes or
rhythms different from the rest of the piece.

A time signatute of 4 beats per measure, where
each beat is the duration of 2 quarter note. Also

‘called 4/4 time.

Time signatures in which the number of beats
per Signature measure can be evenly divided
by 3.

In counterpoins. Playing 2 or more entirely
independent parts {melody line, bass line, etc.,)
at the same time.

A musical pattern in which notes of rising
pitches appear on one staff while notes of
lowering pitches appear on the other staff,




Crossing

Damper

Damper Pedal

Dotted Note

Double-Note

Duration

Eighth Note

Eighth Note Rest
Finger Independence

Finger Number

Fingering
Flat

Forte

GLOSSARY

A fingering technique that involves moving the
thumb to a key that rests under the fingers or
moving the fingers over the thumb that is
holding a note down. It is one way to change
keyboard positions.

A felt-covered device that silences the vibration
of a piano string when the corresponding key on

the keyboard is released.

The right pedal on the piane. This pedal lifts all
of the dampers, allowing the strings to vibrate

freely, even after their comresponding keys are
released. It is also called the loud pedal.

A note thar is played for one-and-a-half times s
normal durarioa.

A 2-note chord.

The amount of time a note is played, in relation
to the other notes.

A note whose duration is one-eighth that of a
whole note. It appears in staff notation asa
solid circle atrached to a stem with a flag,

A rest whose duration equals an cighth note.
Also called an Fighth Rest.

The ability to move each finger independently
of the others.

The numbets that appear above or below the
notes in staff notation to indicate which fingers
to use.

The coordination of hand positions to play the
notes of a piece smoothly.

The sign for a note one half-step lower than the
indicated note.

A musical term meaning fond
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Fortepiano
Grand Piano

Half Note

Half Note Rest
Half Step
Hand Position

Imitative Piece

Improvisation

Interval

Jazz

Key Signature

Keyboard Position

The early name given to the piano (literally,

loud-soft).

A type of piane in which the strings lie
horizontally. It has a graceful curve on one side.

A note that is played for half of the duration of 2
whole note. In staff notation, it looks like
hollowed-out circle with a stem.

A rest that lasts for the same duration as a half
note. It is also called a Haff Rest.

The distance between two adjacent keys on the
keyboard, counting both white and black keys.

The proper way to hold the fingers while
playing,

A type of music in which one musician {or
hand) plays a sequence of notes with a particular
thythmic pattern, then the other musician (or
hand) plays a sequence of equal length, using
the same rhythmic pattern. In many cases, the
sequences have identical melodies.

The art of creating music without following a
specific written or practiced routine.

The distance berween two keys on the keyboard.

A form of music that developed in the United
States in the early 1900s from elements of Blues
and Ragtime. Its style is often characterized by
long improvisational solos and extensive use of
syncopation.

An indicator at the beginning of a staff that
identifies which lines and spaces of the staff
should be played sharp or flax.

The placement of the hand on certain notes of
the keyboard. It is often necessary to move the
hand to different keyboard positions during

play.
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Lead Beats

Ledger Lines

Legato

Length
Local Off

Local On

Loud Pedal

Measure

Melody
Metronome
Middle C

MIDI

MIDI IN

.. GLOSSARY

One measure’s worth of beats, counted off
before a piece statts for the purpose of setring
ternpo.

Short horizontal lines above or below the staff,
arrached to the stem of a note. Used to indicate
the pitch of notes tha fall cutside the range of
the staff,

A technique of playing in which notes appeat to
flow together smoothly.

The duration of a note.

You dont hear the actual sounds of keys on the
keyboard when struck. Some examples of Local
Off are the thythm exercises in The Miracle.

You hear the sounds of keys on the keyboard

when struck.
See Damper Pedal.

A group of notes, framed on the staff berween
vertical bars called bar lines. Each measure in a
piece bas the same number of beats. Normally,
the first beat in 2 measute is stressed. Also called
a Bar.

The tune or theme of a piece. In piano scores, it
usually appears on the treble staff.

A device which makes evenly spaced tick sounds
to help musicians maintain tempo.

The musical note C thar is closest to the center
of the keyboard.

Acronym for Musical Instrument Digital
Interface, which is the system that makes
electronic keyboards compatible with The
Miracle software. '

A MIDI input port that receives information
from The Miracle software on your Macintosh.
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MIDI OUT

Multi- Timbrel

Natural

Qctave

Oscillator

Ostinato Rhythm

Parallel Motion

Patch

Patch Mapping

Piano

Pianoforte

Player Piano

Playing by Interval

Previous Accidental Rule

A MIDI output port that sends information to
The Miracle software on your Macintosh.

More than one instrument voice sounding at the
same time.

The sign for a note that is neither sharp nor flat,

The closest distance between rwo notes with the
same letter name. Including both white and
black keys, this is a range of 12 notes.

An electronic wave form generator used in
synthesizers to create sounds.

A rhythmic pattern that repeats continuously.

A musical pattern in which notes on both staves
rise and fafl in pitch at the same dme.

The number assigned to 2 musical voice or
timbre in The Miracle software.

List of all patches for the current musical output
device,

A musical term meaning soft. Also, shorrt for
pianoforte.

A keyboard instrument that uses a system of
hammers and dampers to contro! the vibration
of strings.

A type of piane invented in the late 19¢h
century that required no performer.

A. technique for reading music in which
distances between notes on the staff are

associated with distances becween keys on the
keyboard.

A special case to the normal rules of staff
notation. When an accidental appears in a
measure, the accidental remains in effect for
future occurrences of notes on that line or space
for the rest of the measure. See Accidental.
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Quarter Note

Quarter Rest

Ragtime

Rest

Rhythm

Romanticism

Russian School

Sequence

Sharp

Sight Reading

Sixteenth Note

Sixteenth Note Rest

Soft Pedal

- GEOSSARY

A note that is played for one quarter the
duration of a whole note. In staff notation it
appears as a solid black circle with a stem.

A rest that lasts for the same duration asa
quarter note.

A style of piano music thar first appeared in the
late 1800s. Pieces are highly syncopated, favor
fast tempos and a more staccato flow.

A moment of silence in music of specific
duration.

The proportions between notes of different
durations.

Schoal of composing and playing with emphasis
on subjective interpretation, emotional qualities,
and freedom of form.

A style of piano begun by Russian composer
Anton Rubinstein that emphasizes fiery
pcrformances and virtuosity.

A pattern of notes and rhythm that repeats three
or more times with cach repetition beginning
higher or lower than the previous one.

The sign for a note one-half step higher than the
indicated note.

Playing a new piece without first studying or
practicing it.

A nore played for 1/16th the duration of a
whole note. In staff notation it appears as a
solid black circle with a stem possessing two

flags.

A rest that has the same duration as a sixteenth
note. Alse called a Sixzeenth Rest.

The left pedal on the piano. When pressed, the

piano produces a more muffled sound.
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Sostenuto

Soundhboard

Staccato

Staff

Staff Notation

Stretches

Sustaining Pedal

Syncopation

Synthesizer

TFapping

Tempo
Theme

Third

See Sustaining Pedal.,

The wooden surface over which the strings of a
piano are stretched. The sound of the vibrating
strings resonate off the scundboard.

A style of playing in which notes are crisp and
separated by silences of varying lengths.

A set of 5, evenly-spaced horizontal lines. Each
fine represents a different note. Each space
between the lines also represent a note. The
space above and below the staff can also
represent notes; see Ledger Lines.

The wricten form of music.

Fingerings that require skipping notes with
adjacent fingers.

The middie pedal on a piano. This pedal
sustains the sound of a note being played (and

only that note} beyond the time when the finger
is lifted from the key.

A style of thythm in which accented notes
appear between beats, rather than on them.

A musical instrument, usually having a
keyboard, that can electronically create a wide
variety of sounds.

A method of learning rhythm in which the
pianist plays a single note on the keyboard in
tme with the thythm of a piece of music.

The overall speed at which a piece is played.

The main melody of a piece, for which the piece
is known and recognized.

An interval of two notes separated by one note.
It is written on two consecutive lines or two
consecutive spaces.
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Tie

Time Signature

Treble Clef

Treble Staff

Triplet

Una Corda

Upright

Variation

Whole Note

Whole Note Rest

- GLOSSARY

A curved line that connects two or more notes
of equal pitch. Such notes are played as a single
note, lasting for the duration of all the tied notes
combined.

The numbers that appear at the left of the first
measure of a piece, indicating the number of
beats per measute (upper number) and the note
duration to which a beat is equal (lower
number). :

The symbol at the left edge of a staff that
identifies it as a treble staff. Sometimes called a

G-clef, because it indicates that the note on the
second line of the staff isa G.

A staff that begins with a treble clef, whose note
pitches are normally associated with the female
voice and bigh-pitched instruments. On the
piano, it is associated with the right haif of the
keyboard.

Three notes played in the same time it would
normally take to play two. They appear in
notation as a set of beamed notes with a swoall 3
above the beam.

A term meaning Soft Pedal.

A type of pianc whose strings are mounted
vertically, thus requiring less floor space than a
grand piano.

A modified repetition of a basic theme,

A note whose duration is 4 times that of a
quarter note. In staff notation, they appearasa
hollow circle with no stem.

A rest that has the same duration as 2 whole
note. Also called a Whole Rest.

&5



THE MIRACLE® PIANO TEACHING SYSTEM SOFTWARE

66



" MACHITOSH CONVENTIONS -

MACINTOSH
CONVENTIONS

The Miracie Piano Teaching System uses these standard
Macintosh principles:

» A standard Macintosh menu bar appears on top of the screen.
When you open a pull-down menu, active commands are
boldface {lit), inactive commands are dimmed, and any keyboard
shortcuts are shown. You can click an active command or press
its shortcut keys, such as  Q to Quit. As you use the program,
notice that menus appear and disappear on the menu,
depending on the activity that you are doing,

Note: The Edit menu is only active when you are adding or
editing a student,

s The mouse operates all program features and some keyboard
features.

* Balloon help is available. You can show or hide ballcons.

MOUSE AND KEYBOARD

With any feature of The Miracle, you can use standard mouse
acrions, including:

» Click - Point and press the mouse button. You click to go to
rooms from the Conservatory; to choose command buttons in
Lessons and reoms; to open menus and choose commands from
the Macintosh menu bar at the top of the screen; and to select
from lists, fields, and check boxes, or choose commands in
dialog boxes.

+ Double-dlick - Poini and click the mouse button rwice rapidly.
For example, you can double-click songs in dialog boxes to open
them for practice.
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Click and drag - Point, hold down the mouse button, and drag
the mouse. You click and drag to “thumb” on the horizental or
vertical scroll bats to reposition lists, such as songs, or settings,
such as volume.

For some but not all features of The Miracle, you can use a
keyboard alternative to the mouse, including:

Typing - When you add a new student, you type that person’s

namie.

Scrolling - Press cursor keys to move up and down sclection lists
as alternatives to clicking scroll bar arrows or clicking and
dragging the scroll bar thumb,

Okaying - Press Return to confirm a choice. This is an
alternative to double-clicking and to clicking the OK burron.

Canceling - Press Esc to cancel 2 choice {(an alternative to
clicking the Cancel button,)

Command Keys - Press 88 and the letter or number shown next
to certain menu commands te choose those commands without
a mouse. For details see Quick Reference,




*_MACINTOSH CONVENTIONS

QUICK REFERENCE
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